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1 Introduction 

1.1 About this Manual 

This manual comprises all important information about the installation and operation of the 
stimulus generator STG1000 series and MC_Stimulus software. It is assumed that you have already 
a basic understanding of technical and software terms. No special skills are required to read this 
manual. 

If you are using the STG for the first time, please read the important safety advice before 
installing the hardware and software (see Important Safety Advice, where you will find 
important information about the installation and first steps). 

The printed manual and Help are basically the same, so it is up to you which one you will use. 
The Help offers you the advantage of scrolling through the text in a non-linear fashion, picking up 
all information you need, especially if you use the Index, the Search function, and the Browse 
Sequences. If you are going to read larger text passages, however, you may prefer the printed 
manual. 

The device and the software are part of an ongoing developmental process. Please understand 
that the provided documentation is not always up to date. Check also the MCS Web site 
(www.multichannelsystems.com) from time to time for downloading up-to-date manuals and new 
software versions. 

1.2 Terms of Use for MC_Stimulus 

You are free to use MC_Stimulus for its intended purpose. You agree that you will not decompile, 
reverse engineer, or otherwise attempt to discover the source code of the software. 

1.3 Limitation of Liability 

Multi Channel Systems MCS GmbH makes no guaranty as to the accuracy of any and all tests and 
data generated by the use the MC_Stimulus software. It is up to the user to use good laboratory 
practice to establish the validity of his findings. 

To the maximum extent permitted by applicable law, in no event shall Multi Channel Systems MCS 
GmbH or its suppliers be liable for any special, incidental, indirect, or consequential damages 
whatsoever (including, without limitation, injuries, damages for data loss, loss of business profits, 
business interruption, loss of business information, or any other pecuniary loss) arising out of the 
use of or inability to use  MC_Stimulus or the provision of or failure to provide Support Services, 
even if Multi Channel Systems MCS GmbH has been advised of the possibility of such damages. 
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2 Important Information and Instructions 

2.1 Operator's Obligations 

The operator is obliged to allow only persons to work on the device, who 

• are familiar with the safety at work and accident prevention regulations and have been instructed 
how to use the device; 

• are professionally qualified or have specialist knowledge and training and have received 
instruction in the use of the device; 

• have read and understood the chapter on safety and the warning instructions in this manual and 
confirmed this with their signature. 

It must be monitored at regular intervals that the operating personnel are working safely. 

Personnel still undergoing training may only work on the device under the supervision of an 
experienced person. 

2.2 Guaranty and Liability 

The General conditions of sale and delivery of Multi Channel Systems MCS GmbH always apply. 
The operator will receive these no later than on conclusion of the contract. 

Multi Channel Systems MCS GmbH makes no guaranty as to the accuracy of any and all tests and 
data generated by the use of the device or the software. It is up to the user to use good 
laboratory practice to establish the validity of his findings. 

Guaranty and liability claims in the event of injury or material damage are excluded when they 
are the result of one of the following. 

• Improper use of the device 

• Improper installation, commissioning, operation or maintenance of the device 

• Operating the device when the safety and protective devices are defective and/or inoperable 

• Non-observance of the instructions in the manual with regard to transport, storage, installation, 
commissioning, operation or maintenance of the device 

• Unauthorized structural alterations to the device 

• Unauthorized modifications to the system settings 

• Inadequate monitoring of device components subject to wear 

• Improperly executed and unauthorized repairs 

• Unauthorized opening of the device or its components 

• Catastrophic events due to the effect of foreign bodies or acts of God 

2.3 Important Safety Advice 

 

Warning: Make sure to read the following advice prior to install or to use the device and the 
software. If you do not fulfill all requirements stated below, this may lead to malfunctions or 
breakage of connected hardware, or even fatal injuries. 

 

Warning: Obey always the rules of local regulations and laws. Only qualified personnel should 
be allowed to perform laboratory work. Work according to good laboratory practice to obtain 
best results and to minimize risks. 
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The product has been built to the state of the art and in accordance with recognized safety 
engineering rules. The device may only 

• be used for its intended purpose; 

• be used when in a perfect condition. 

• Improper use could lead to serious, even fatal injuries to the user or third parties and damage to 
the device itself or other material damage. 

 

Warning: The device and the software are not intended for medical uses and must not be used 
on humans. 

Malfunctions which could impair safety should be rectified immediately. 

High Voltage 

Electrical cords must be properly laid and installed. The length and quality of the cords must be in 
accordance with local provisions. 

Only qualified technicians may work on the electrical system. It is essential that the accident 
prevention regulations and those of the employers' liability associations are observed. 

• Each time before starting up, make sure that the mains supply agrees with the specifications of 
the product. 

• Check the power cord for damage each time the site is changed. Damaged power cords should 
be replaced immediately and may never be reused. 

• Check the leads for damage. Damaged leads should be replaced immediately and may never be 
reused. 

• Do not try to insert anything sharp or metallic into the vents or the case. 

• Liquids may cause short circuits or other damage. Keep the device and the power cords always 
dry. Do not handle it with wet hands. 

Requirements for the installation 

• Make sure that the device is not exposed to direct sunlight. Do not place anything on top of the 
device, and do not place it on top of another heat producing device. Otherwise, the device may 
overheat. 
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3 First Use of the Stimulus Generator 

3.1 Welcome to the STG and MC_Stimulus 

Product line overview 

Stimulus generators of the 1000 and 2000 series are 
general/purpose stimulators designed to serve a very wide variety 
of applications, both in vitro and in vivo. 

Flexible and easy-to-use MC_Stimulus software enables complex 
stimulus waveforms (both current and voltage). Waveforms 
designed in the program or imported from an external ASCII file 
are converted by the connected STGs into pulses, which are sent 
to stimulating electrodes. Stimulus isolation units (SIU) for each 
channel are included. Thus, no external SIUs are required. 

A trigger input and output for TTL signals allows to synchronize the stimulus generator with other 
instruments. Triggering of other devices via programmable TTL pulses (Sync Out) is possible, as 
well as triggering of the STG by external devices via the Trigger In input. For example, you can 
synchronize stimulation and recording with a digital trigger signal sent from the Sync Out 
output of the STG to the MC_Card. 

Stimulus generators are available for simultaneous stimulation on up to 8 channels 
(STG1001STG1008, STG2004, STG2008). 

2000 Series 

The real-time stimulus generator of the 2000 series is an advanced version and the world's first 
STG that is able to send continuous pulse streams to stimulating electrodes. In addition, you can 
trigger all (up to 8) channels separately by external TTL pulses. 4 trigger inputs (Trigger In) 
and4 trigger outputs (Sync Out) are shared by 8 channels in the 8-channel version. 

MC_Stimulus 

Stimuli are created user-friendly by entering the desired pulses (rectangular, ramp, or sine 
waveforms) into a worksheet. Waveforms can be combined freely to create virtually any stimulus 
pattern. 

Created stimuli are displayed in a WYSIWYG stimulus display. All channels are set up 
separately. 

For even more convenience, repetitive stimulus patterns do not have to be entered separately, 
but can be grouped and looped. You can also import waveforms in ASCII file format and use 
them for stimulation. You can print and save stimuli and comments for later use and 
documentation of your experiments. 



Stimulus Generator 1000 Series User Manual 

6 

 

3.2 Setting Up and Connecting the STG 

Provide a power supply and a computer with RS232 serial port in the immediate vicinity of the 
installation site. Make sure the STG is switched off before you connect it to the power supply. 

1. Place the STG on a stable surface, where the air can circulate freely and the STG is not exposed to 
direct sunlight. 

2. Plug the main cable into the socket on the back of the STG. 

3. Connect the main cable to the power outlet. 

4. Connect the RS232 connector to the serial port of the computer. The computer connection is 
necessary for programming the STG, but not for operating it (except in Batch mode). 

5. Connect the required output channels with 2 mm plug cables to the stimulating electrodes. Use 
the +U or U outputs for voltage stimuli, and +I or I outputs for current stimuli. Connect the 
appropriate ground to the ground input of the stimulation setup, for example to the ground 
input of the MEA1060 amplifier. See also chapter "Output Signals" for more information and 
illustrations showing suggested setups. 

6. (Optional) Connect the required Trigger In input with a BNC cable to an instrument that produces 
TTL signals for triggering the STG. 

7. (Optional) Connect the required Sync Out output with a BNC cable to a following instrument that 
you want to be triggered by TTL signals from the STG, for example to one of the 16 digital inputs 
of the MC_Card. 

8. Switch the STG on by pressing the toggle switch on the rear panel. 
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3.3 Installing the Software 

System requirements 

Software: One of the following Windows© operating systems is required: Windows 2000 or 
Windows XP (English and German versions supported). Other language versions may lead to 
software errors. 

Hardware: RS232 serial port 

Installing the software 

Please check the system requirements before you install the software. MCS cannot guarantee that 
the software works properly if these requirements are not fulfilled. 

Important: Please make sure that you have full control over your computer as an administrator. 
Otherwise, is possible that the installed software does not work properly. 

1. Double-click Setup.exe on the installation volume. 
The installation assistant will show up and guide you through the installation procedure. 

2. Follow the instructions of the installation assistant. Please select the appropriate maximum 
number of analog output channels according to the connected STG. If you have different STGs in 
use, choose the highest number. 

 

When you have finished the installation of the MC_Stimulus software, you can now operate the 
STG. 
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4 Operating the STG 

4.1 Operation Overview 

 

Warning: Make sure that you do not come in contact with the cables or the connectors of the 
STG after you have started the STG. The high voltage and power can lead to injuries. 

 

Warning: Do not start the STG if you are unsure about the channel configuration or the nature 
of the downloaded file. 

1. Set up your experiment. 

2. Switch the STG on. 

3. Set up your stimuli with the MC_Stimulus program. 

4. Send the stimulus sequence from an MC_Stimulus file to the STG. 

5. Start the STG either manually by pressing the Start/Stop button on the front panel, with the 
software controls, or with an external trigger. 

Creating stimuli 

Stimuli are created user-friendly by entering the desired pulses (rectangular, ramp, or sine 
waveforms) into an MC_Stimulus worksheet. Waveforms can be combined freely to create virtually 
any stimulus pattern. Created stimuli are displayed in a WYSIWYG window. 

Starting stimulation 

Note: You need a computer connection only when you are using the software controls for starting 
and stopping the stimulus generator. When you are using the STG interface or an external control 
(trigger), you can disconnect the stimulus generator from the computer and operate it 
independently. But you cannot remove the STG from the power connection. The memory is 
cleared when the STG has lost power. 

After the download of the stimulus file on the STG, you can start the stimulation. There are 
several ways to start the STG. 

MC_Stimulus 
interface: 

You can start the stimulation directly after the download (with the command 
Download and Start (sel.) or Download and Start (all), or also later with 
the command Start. You can stop stimulation with the command Stop. 

 

STG 
interface: 

You can start the stimulation by pressing the Start/Stop button on the front 
panel of the STG. Press the button again to stop the stimulation.  
 

External 
control: 

You can start the stimulation on a trigger from an external device, for example, 
a switch. The trigger works  the same way as when you press the Start/Stop 
button.The STG is stopped when a trigger event occurs during the time when 
any channel is still active. 

STG status control 

Two status control LEDs (light-emitting diode) are present on the front panel of the STG to give 
you a quick overview on its status. 

POWER Lights yellow during startup. Lights green if STG is on. Lights red if STG is in a bad 
state. 
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SWEEP Lights green if stimulus file has been downloaded to STG. STG is now ready to use. 
Lights orange when stimulation is running, that is, output channels are active. 

4.2 Operating Multiple STGs 

If you have more than one STG connected to the same computer, you can choose which STG you 
like to control from the currently active MC_Stimulus program. 

• The serial port of the currently active STG is displayed on the status bar of the currently active 
instance of the MC_Stimulus program. 

 

• Click Port Settings and then select the serial port to which the 
selected STG is connected. 

• You can open multiple instances of the MC_Stimulus program 
and control multiple STGs at the same time. Please make sure 
that you control each STG only by one MC_Stimulus instance. 

• You can also open only one MC_Stimulus instance and control 
multiple STGs one after the other by the same instance. Simply 
change the Port Settings and select the next STG when you 
have finished to program the first. The STGs can be operated 
without a computer connection. 
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5 Programming Stimulus Protocols 

5.1 MC_Stimulus Worksheet 

You can freely combine any pulse types. Use a separate row for each pulse type. 

Hint: Several tools are provided for editing whole columns at once or autocreating entries. 

1. Select the desired output type first. Click either Voltage or Current under Output Mode on 
the file window of MC_Stimulus. 
 

 

2. Click a tab to select an output channel. 
The according channel worksheet is brought to front. 
 

 

3. Now you can enter the pulses into the worksheet. Select a Pulse type (either rectangular, ramp, 
or sine). 

4. Enter the desired voltage steps and a time length for each step. 
 

 
 
The according pulse is displayed in the WYSIWYG display at once. 
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5.2 Pulse Types 

Three basic pulse types are available in MC_Stimulus. You can create virtually any pulse by 
combining different types. 

• Rectangular 

• Ramp 

• Sine wave 

Note: The time resolution is 20 μs. When you enter time steps that are not a multiple of 20 μs, 
the length of the step is internally adjusted to a valid value. The changed values do not show up 
in the worksheet, but invalid values are highlighted in yellow or red. The minimum voltage 
resolution is 2 mV, the current resolution is 1 μA. Please regard also the minimum and 
maximum output voltage/current of your STG version. 

Note: If you work near the resolution limits of the STG, the output pulses may differ from the 
programmed pulses. In this case, you should check the output with an oscilloscope. Please see 
also the "Analog Output Signals" chapter. 

 

Note: The total pulse length of all channels has to be identical. If the stimuli of two channels 
have different lengths of time, the last used value of the shorter channel is kept until the longest 
stimulus has been finished. You will be notified with an error message at the beginning of the 
download. 

Please note that the memory of the STG is limited. You will get an error message if the memory is 
full. The new generation of stimulus generators (STG2004/8) has 16 times more memory and an 
improved internal memory management, perfect for sophisticated or long-term stimulus 
protocols. 

For the digital Sync channel, only bit patterns of 0 (LOW) and 1 (HIGH) can be programmed. A 
logical state of 1 (HIGH) results in a 5 V output signal, and a logical state of 0 (LOW) results in a 0 
V output. Please note that the digital output is sent about 20 μs faster than the analog output. 
Please see also the "Triggering Stimulation" chapter. 

Rectangular pulse type 



Programming Stimulus Protocols 

13 

 

• Enter each voltage/current level and the duration of the pulse. The voltage/current jumps 
directly to the specified level. In one row, you can enter up to three voltage/current levels. Use the 
next row for programming more levels. 

Ramp pulse type 

 

• Define the starting point, end point, and the length of the ramp. The ramp is then build 
according to these parameters in small single steps of 20 μs. 

Sine wave pulse type 
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• Define the amplitude and the period of the sine wave. The sine wave is then computed 
according to these parameters with a minimum resolution of 2 mV and 20 μs. If you enter a 
negative amplitude, the sine wave starts with its negative alternation. 

5.3 Autorepeating Pulses and Protocols 

 

For entering complex stimuli easier and faster, you can repeat rows and groups instead of 
entering the pulses several times into the worksheet. You can repeat each single row. In the 
preceding example, the rectangular pulse in row 1 is repeated twice. You can also group several 
rows and repeat them altogether. In the example, pulses from rows 1 to 4 are grouped and 
repeated three times. 

Repeating rows 

• Type the number of repeats into the Row Repeat cell of the appropriate row. 
The pulses of the complete row are than repeated the specified number of times. 

Grouping and repeating groups 

1. Select several cells by clicking and dragging cells in the Group Repeat column. 
Selected cells are highlighted in black. 
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2. Point to the selected cells and right-click to open the context menu. 
 

 

3. Click Group/Ungroup. 
The corresponding rows are grouped now. This is indicated by a merging of the Group Repeat 
cells. 

4. Type the number of repeats into the merged Group Repeat cell. 
 

 

Repeating complete pulse protocols (autorepeat function), Continuous Mode 

1.  
2.  

You can also repeat all stimuli on all channels, that is, the whole file either continuously (until 
stopped manually by the user) or a specified number of times. 

 

• Under Repeat, select continuously for repeating the stimulation until the STG is stopped by the 
user. 

• Under Repeat, select n times and enter a number for repeating the stimulation n times. 

5.4 Autocreating Entries and Editing Columns 

Changing time units for a complete column 

1. Click any Unit column header to select a column. 
The selected column is highlighted in black. 
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2. Right-click and click Change Time Unit. 
 

 

3. Select the desired time unit. 
 

 
 
All units in the column are set to the selected time unit. 
 

 

Inverting pulses in a column 

1. Click any Value column header to select a column. 
The selected column is highlighted in black. 
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2. Right-click and click Invert Selection. 
 

 
The polarity of the signals is switched from positive to negative and vice versa. 
 

 

Incrementing columns 

This feature is very convenient for setting up long and complex stimuli without entering each 
value manually. You can enter and edit multiple voltage values or time lengths. 

You can keep all zero values unchanged with the option Keep Zero. 

Apart from an absolute shift or increment factor, you can modify values by the percentage as 
well. 

Shifting time or voltage/current values 

You enter a value, which is added arithmetically to all values in the selected column. For example, 
if you enter "50", 50 is added to all values. 

1. Click any Value or Time column header to select a column. 
The selected column is highlighted in black. 
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2. Right-click and click Increment Selection. 
 

 

3. Under Type of Increment, select Shift. 

4. Enter the desired value. 

 

All values in the selected column are modified by the selected factor. In the example, 100 is added 
to all values, resulting in a total of 100 because the initial value has been 0. 

 

Creating time or voltage/current increments 
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With this option, you enter a base value for modification of all values in the selected column. The 
first row is modified by the base value. The second row is modified by the double value, the third 
row by thrice the base value, and so on. With this feature, you can easily set up time or voltage 
increments. 

1. Under Type of Increment, select Count. 

2. Enter the desired start value. 

 

The value in the first row is incremented by the selected start value of 10. The next value is 
modified by the double value (20), and so on. 

 

You can now fill further columns in the same way. Thus, you can easily set up a stimulus with 
incremented pulse lengths like this with only a few mouse-clicks. 
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In the same way, you can set up a stimulus with voltage/current increments. 

 

Shifting absolute time or voltage values 

With this option, the signs of the selected values are ignored. Zeros are never changed, that is, the 
option Keep Zero cannot be deselected. 

1. Under Type of Increment, select Absolute Value. 

2. Enter the desired shift factor. 
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The absolute values of 200 and 200 are both 200. This absolute value of 200 is modified by the 
shift factor of 50, resulting in 250. The negative value is now 250, and the positive value is 250. (If 
you had chosen the option Shift instead, the computed result would have been 200 + 50 = 150.) 
All zero values are not changed. 

 

Autocreating entries 

You can use the Autofill feature to set up advanced time or voltage/current increments. You 
define the Start and End value and either the Step Size (Start - Stop - Step Size) or the 
number of Steps (Start - Stop - # of Steps). Alternatively, you can enter the Step Size and the 
Number of Steps (Start - Step Size - # of Steps). According to these specifications, rows are 
inserted and the column is filled automatically. 

In the following example, the Autofill feature has been used to create a voltage step series from 
20 mV to 500 mV with an increment of 20 mV. 

1. Click any Value or Time column header to select a column. 
The selected column is highlighted in black. 

2. Right-click and click Autofill. 

3. Select one out of three commands and fill in the white text boxes. 

 

The column is filled according to the specifications. 
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5.5 Auto Sync for Autocreating Trigger Pulses 

If you want to synchronize other devices, for example a MEA1060-BC amplifier or the MC_Card 
with the stimulus generator, you have to set up the digital output of the Sync Out channels in 
synchrony to the stimulus pulses. This may sometimes be a bit tricky and time consuming, 
especially for complex stimulus protocols. 

The Auto Sync feature is intended for making the work with MC_Stimulus more efficient: Digital 
Sync Out TTL pulses synchronous to stimulus pulses are generated automatically by this feature. 
Each time an analog channel generates a pulse (that is, its value is not equal to zero), the logical 
state of the assigned Sync Out channel is set to HIGH (=1). You can set the time offset of the 
TTL's rising edge before the stimulus pulse and of the TTL's falling edge after the pulse.  If you 
change the stimulus protocol, corresponding Auto Sync pulses are updated on the fly. This 
feature is especially recommended for controlling the MEA1060-BC amplifier with superior 
stimulus artifact suppression. 

1. On the Edit menu, click Auto Sync Settings. 
The Auto Sync Settings dialog box appears. 

 
  

2. Assign the analog stimulus channels that will be used as the basis for autocreating the protocols 
on the Sync Out channel. For example, if you use only stimulus channel 1, select Ch1 under Sync1. 
If you use a MEA1060-BC amplifier, you can use up to two output channels per amplifier, that is, 
you may want to select Ch1 and Ch2 for Sync1, as shown in the preceding screen shot. 
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3. Set the time offset of the TTL's rising edge before the stimulus pulse (Pre Time) and of the TTL's 
falling edge after the pulse (Post Time). For operating a MEA1060-BC amplifier, a Pre Time of 0 
μs and a Post Time of 100 μs are default, but especially the Post Time may have to be adjusted 
according to your stimulus amplitude and the stimulus artifact suppression performance (please 
see the user manual of your MEA1060-BC amplifier or the MEA_Select Help for more details). 

4. On the Settings menu, click Auto Sync to enable the Auto Sync feature. 
The Sync Out protocols will be autocreated in synchrony with the pulse protocols on the assigned 
channels, will show up in the WYSIWYG window immediately, and will be downloaded onto the 
STG with your next download. The worksheets of the Sync Out channels assigned to the Auto 
Sync feature will be unavailable, that is, you cannot edit them manually. The following screen 
shot shows an example of a monophasic 100 μs voltage pulse on channel 1 and the corresponding 
Auto Sync pulse (Pre Time 0 μs, Post Time 100 μs) on Sync Out 1. 
 

 

5. If you later choose to edit the Sync Out worksheets of the active file manually, you can deselect 
the Auto Sync feature on the Settings menu. 
Any information in the Sync Out worksheets that was there before the Auto Sync option was 
enabled will be restored; and all worksheets will be available for manual editing. 
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6 ASCII Import/Export 

6.1 Loading Files 

The ASCII import filter is used to load stimulus protocols from an ASCII file into the stimulus 
worksheet of MC_Stimulus. You can use this feature for feeding recorded signals (for example, 
exported from MC_Rack, see the MC_Rack User Manual) into the stimulus generator. 

The current version of the import filter is version 1.10. Only rectangular waveforms are 
supported in this version. 

 

Fig. 1 ASCII import example: Stimulating with biopotential waveforms 

Shown is a single spike recorded from an organotypic hippocampal culture. The spike waveform 
was exported as ASCII from MC_Rack and imported into the MC_Stimulus program.  

 

Warning: All previous records in the active MC_Stimulus file (.stm) file are overwritten. Please 
create a new file and import the data into an empty worksheet to avoid data loss. 

1. On the File menu, click Import ASCII File. 
The Open dialog box appears. 
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2. Select an appropriate ASCII file and click Open. 
The stimuli from the ASCII file are loaded into the active MC_Stimulus worksheet. All previous 
records are overwritten. Channels that are not present in the ASCII file are empty. You can now 
edit and download the stimulus file as usual. 

If the file does not fulfill the requirements of a stimulus file, an error message will show up and 
tell you in which line the first error occurs. See "Supported File Format" for more information 
about supported ASCII files. 

6.2 Exporting Files 

1. On the File menu, click Export ASCII File. 
The Save As dialog box appears. 

2. Browse to the target folder and enter a file name. 

3. Click Save to generate the ASCII file. 

All pulse protocols from the active file will be saved in ASCII file format. The MC_Stimulus ASCII 
format type is format type 4. For your convenience, the generated ASCII file includes the header 
that is required for reimporting the file into MC_Stimulus. 

6.3 Supported File Formats 

The ASCII text must exactly follow the specifications below. The parameters in angle brackets are 
placeholders for any valid numbers or strings. 

Hint: You can set up files conveniently in any standard spreadsheet program and save them as 
tab-delimited ASCII. 

General 

• The file name and the file name extension are not important. You can use any extension you 
like, for example .txt, or .dat, or any other. 

• Comments are introduced by the number sign #. The rest of the line after # is only for your 
information; it is completely ignored when executing the stimulus file. (You do not need 
comments, of course, but it is convenient for documentation.) 

Hint: Use # to comment lines out. That is, you can disable lines without removing it from the file. 
Thus, you can keep the lines for later uses. 

• Blank lines are ignored. 

• The spelling is strict. The MC_Stimulus program does not recognize a keyword if it is misspelled 
or if even only one character is missing, but it is not case-sensitive. 

• The file has the following structure. 

1. File header 

2. Data 

File header 

The first two non comment lines have to be the following lines. Files for older versions of the 
import filter (version 1.00) can be imported with the current version as well. 

Multi Channel Systems MC_Stimulus 
ASCII import Version 1.10 
 
The next three lines have to be the following lines (in any order). 
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channels: <number> 
output mode: <mode> 
format: <format number> 
 
Make sure you define the total number of channels for the used STG properly (4 channels for an 
STG with 4 channels, 8 channels for an STG with 8 channels, and so on), according to the 
software version. You can select the maximum number of channels during the installation of 
MC_Stimulus. On the Help menu, click About MC_Stimulus to check your current software 
version. 

Example: 

You have to include the following line in the ASCII file if you have installed MC_Stimulus for 
STG1004. 

channels: 4 

 
Output mode is either voltage or current. 

Example: 

output mode: voltage 

 
Three different format types are available: 1, 2, 3. 

Example: 

format: 3 

Data 

Preceding the data, the output channel number has to be specified by the following line. 

channel: <channel number> 
 
You can specify analog output channels from 1 to 8 (limited by the number of analog output 
channels of the connected STG, of course). 

The digital Sync Out channel number directly follows the maximum number of output channels. 
For example, if you have installed MC_Stimulus for 4 channels, the Sync Out channel is channel 
number 5; if you have installed MC_Stimulus for 8 channels, the SyncOut channel is channel 
number 9. 

The data follows after the channel specification line; three format types are available. All format 
types follow the MC_Stimulus worksheet's structure of rows and columns. See the description of 
the worksheet for more details. Columns are separated by blanks or tabs. The first line has to 
contain the column headers. The following lines contain the voltage/current and time values. 
Rows/lines are separated by a carriage return or line feed (CR/LF). This is the Windows standard 
control character inserted when you press the ENTER key. 

The voltage unit is mV and the current unit is μA. Please make sure that all values are in the 
ranges specified for the STG you use. For the Sync Out channel, only values of 0 and 1 are allowed. 

The time unit is μs. Time values can be in the range from 20 to 18.000.000.000 (20μs to 5 h). Time 
base of the STG is 20μs, so only times that are multiples of 20μs are valid.  

Note: Please make sure that there are no additional tabs or characters, which would lead to an 
error message. Show tabs and spaces in your text editor and check the file before importing it. 

Format type 1 
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This is a basic format with two columns of Value and Time each, without Repeat functionality. 

value time value time    

Format type 2 

With this format, you can repeat rows in the same way as described for the worksheet. Group 
repeat is not available. 

value time value time repeat   

Format type 3 

This format type is available only in the current version of the import filter. It allows you to use a 
third column of Value and Time. 

value time value time value time repeat 

Example: 

The following picture shows an ASCII stimulus file opened in a standard spreadsheet program. 

 

The same file would look like this in a standard text editor program. You can see the tabs, spaces, 
and CR/LF. 
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After loading the file into the MC_Stimulus worksheet, you can edit and download the file as 
usual. 

 

Format type 4 

This format type is available only in the current version of the import filter. It is the plainest 
format with only one column for the voltage/current values and one column for the time 
lengths. This format is the standard format if you want to import data for example from Excel. 

This format type is generated when exporting MC_Stimulus files as ASCII. 

value time      

Format type 5 
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This format type is available only in the current version of the import filter. It allows you to use 
ramp and sine waveforms as well as rectangular waveforms. You specify the Pulse type in the 
first column, and the waveform in the three following columns. The general rules for setting up 
ramp and sine waveforms fully apply (see also Pulse Types). The pulse types are defined by the 
following numbers: Rectangular = 0, ramp = 1, sine = 2. 

You can only use the rectangular type (0) for the Sync Out channels. 

Important: When setting up rectangular or sine waveforms in this format type, you need only 
one value column for defining the amplitude, but you have to define both value columns even so. 
The first value column is ignored for rectangular and sine pulse types by the MC_Stimulus 
program. 

pulse 
(0, 1, 
2) 

value value time    

Example: 

This is an ASCII file viewed in a standard text editor program. You can see the tabs, spaces, and 
CR/LF. 

For demonstration purposes, a ramp type pulse was programmed on the first channel, a sine wave 
on the second channel, a rectangular waveform on the third channel, and mixed pulse types on 
the fourth channel. 
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After loading the file into the MC_Stimulus worksheet, you can edit and download the file as 
usual. 
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7 Stimulus Display 

7.1 Selecting Channels 

To enlarge the display size of the channels, we suggest that you show only those channels you are 
currently working with. 

Note: This will affect only the display. It has no effect on the download of signals. To select or 
deselect channels for downloading, click the Download Channel check boxes in the main 
window of the program. 

• Clear the check box of all channels that are not in use. 

All channels that are not selected are removed from the display. 

 

7.2 Display Tools 

• Several tools are provided to optimize the graphical presentation of the stimuli. If you later 
choose to display channels, the axes of the new displays are set to the default values. 

• The time axis can display only positive values. 

• The y-axis of the Sync Out channels cannot be adjusted, because only values of 0 and 1 are 
available for these channels. 

 

 
Enable 
scrolling 

Scroll the axes by clicking and dragging with your mouse. 

 
Enable 
scaling 

Zoom the axes by clicking and dragging with your mouse. 

 
Zoom out Reduces the time scale. 

 
Zoom in Magnifies the time scale. 

 
Reset Resets the axes of all channels to the default values. 

 
Size to fit 

 

Adjusts the ranges to fit the largest displayed stimulus. 

 
Show 
measure 
tool 

A horizontal bar is shown that displays the current/voltage and the time 
value of the intersection point. Drag the bar with the mouse.  
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Scrolling the axes 

You can scroll the stimuli forward and backward along the time axis, and up and down along the 
voltage/current axis. 

1. Click   to enable the scrolling. 

2. Click the axis you like to scroll. 
The mouse pointer becomes a hand. 

 

3. While holding down the mouse button, move the axis to the left and right, or up and down. 
OR  
You can use the keyboard: Press LEFT ARROW or DOWN ARROW to move the axis to the left 
(down), RIGHT ARROW or UP ARROW to move the axis to the right (up). 
OR  
Use the PAGE UP and PAGE DOWN keys for a faster scrolling (larger steps): PAGE DOWN to move 
to the left (down), PAGE UP to move to the right (up). 

Zooming the display 

1. Click  to enable the scaling. 

2.    Click the axis you like to scale. 
The mouse pointer becomes an arrow. 

 

3. While holding down the mouse button, move the mouse up/right to zoom the axis in, and move 
the mouse down/left to zoom the axis out. 
OR  
You can use the keyboard: Press LEFT ARROW or DOWN ARROW to zoom the axis out, RIGHT 
ARROW or UP ARROW to zoom the axis in. 
OR  
Use the PAGE UP and PAGE DOWN keys for a faster scrolling (larger steps): PAGE DOWN to zoom 
out, PAGE UP to zoom in. 

Size to fit 
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• Click  to size the display to fit. 
The ranges are automatically adjusted to fit the maximum amplitude of each stimulus. The range 
of the time axis will be set to fit the longest signal. 
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8 Downloading Stimuli 

8.1 Downloading Stimulus Files 

After having set up the stimulus file, you can download the file to the connected STG. You can 
select the channels that you want to download or download the complete file. The Sync 
channel for synchronizing other devices connected to the Sync Out of the STG will always be 
downloaded, you cannot deselect it. 

You can start the stimulation directly after the download, or start it manually with the software 
or hardware controls, or start it on a trigger. See also chapter "Operating the STG" for more 
information. 

Please note that the capacity of the 1000 series is limited. You will be notified during the 
download by an error message when the maximum file size has been reached. 

See also chapter "Batch Mode" for information how to run multiple files one after the other. 

 

Warning: Check the file thoroughly before downloading it on the STG. The stimulus display is 
independent from the worksheet and from the download. Verify that you download only the 
channels that you want to use. Do not start the STG if you are unsure about the channel 
configuration or the nature of the downloaded file. 

 

Warning: The stimulus length has to be the same on all channels. If you have programmed 
stimuli with different time lengths, shorter stimuli will keep the last voltage or current value 
until the complete stimulation has been finished on all channels. You will be notified by an error 
message if this occurs. This behavior can lead to unexpected results and can even lead to 
dangerous situations. 

1. Select the channels for downloading under Download Channel. 
 

 

2. On the STG menu, click either Download (sel.) to download only the selected channels onto the 
STG or Downld. and Start (sel.) to download only the selected channels and start the 
stimulation directly after the complete download. If you want to download all channels, you can 
use the commands Download (all) or Downld. and Start (all). Be careful, because the channel 
selection will have no effect in this case. 

Disable/enable warning messages 

Cancel this option to disable the message boxes displaying compiler warnings during stimulus 
download. 

The two error messages that can be disabled are: "warning: signal length shorter than the 
maximum" and "warning: non zero last amplitude value". They may present a nuisance if you 
download multiple stimulus files in batch mode. 

• On the Settings menu, select or deselect Enable Compiler Warnings. 
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9 General Software Features 

9.1 Customizing the Main Window 

You can customize the size and position of open file windows and the toolbar in MC_Stimulus. 

• You can hide the toolbar and the status bar by deselecting them on the View menu. 

• You can arrange the windows with the commands on the Window menu. 

• Cascade: Use this command to arrange multiple opened windows in an overlapped fashion. The 
windows are resized to the standard size. 

• Tile: Use this command to arrange the windows so that they are not overlapping. 

• Arrange Icons: Use this command to line up minimized windows. 

• You can resize the windows with your mouse. 

• Click an empty area on the toolbar, and then drag the toolbar to a new position. 

9.2 Menu Bar 

You will find most software features in the pull-down menus of the main window. Each menu 
displays a list of commands. Commands that are not available at the moment appear shaded. 

Use the ... 

• File menu to create new files, save files, import ASCII files, and print the stimulus worksheet. 

• Edit menu for general editing features like copy and paste rows, remove the last entered value 
(Undo), remove and insert rows into the active worksheet. You can also right-click on a row and 
select these commands. Click Clear Signal to delete all values in the active worksheet. You can 
also specify the output ranges according to the connected STG on this menu. Please see the 
technical specifications of your STG. 

• The STG menu contains all commands directly relating to the hardware, for example download 
commands, start and stop the STG, and trigger configurations. Reset deletes all data on the STG's 
memory. 

• You can open, start, and stop a batch run of several files on the Batch menu. 

• Signal menu for nice editing features like editing whole columns, and autocreate signals. You can 
also right-click on a column and select these commands. 

• View and Window menu to customize the main window. 

• Settings menu to define general settings of the software. 

• Help menu to open the MC_Stimulus Help and to display the About dialog where you can find 
information about the hardware, software, and firmware versions. You will need this information 
when you contact the support. 

9.3 Toolbar 

For your convenience, you will find some of the more commonly used commands as a button on 
the toolbar. 

 

 
New File Creates a new MC_Stimulus file (*.stm) file 
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Open File Opens a previously saved MC_Stimulus file (*.stm) file 

 
Save File  Saves the *.stm file to the chosen destination 

 
Cut Row Deletes selected row(s) and sends deleted row(s) to clipboard 

 
Copy Row Sends selected row(s) to clipboard 

 
Paste Row Pastes row(s) from clipboard and overwrites row(s) starting at the 

selected row 

 
Print Prints active channel of active worksheet 

 
Information Opens the About dialog, where you can find information about the 

hardware, software, and firmware versions  

 
Start Starts downloaded stimulation file (only available if STG has active 

computer connection) 

 
Stop Stops downloaded stimulation file (only available if STG has active 

computer connection) 

9.4 Shortcut Keys 

Shortcut keys offer you another way to accomplish common tasks. Using a shortcut key usually 
consists of pressing and holding one key while pressing a second key. 

See the list of shortcut keys available in the software. 

CTRL+A Download and Start (selected) 

CTRL+C Copy Row 

CTRL+D Download (selected) 

CTRL+L Download (all) 

CTRL+N Create New File 

CTRL+O Open File 

CTRL+P Print 

CTRL+R Start 

CTRL+S Save file 

CTRL+T Stop 

CTRL+V Paste Row 

CTRL+X Cut Row 

CTRL+Z Undo 

 

Hint: Shortcut key combinations are also listed on the toolbar menus. For example, the File menu 
shows that the shortcut key for Save is CTRL+S. 

9.5 File Menu 

You can save MC_Stimulus files for later use. This is very convenient if you have various similar 
experimental setups, or if you like to repeat an experiment later. 

Open a file 

You may open previously saved files for similar experimental setups. 
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1. On the File menu or on the toolbar, click Open . 

2. Browse your folders and choose the desired file. You may only open MC_Stimulus files (*.stm). 

3. Click Open. 
The selected file opens. 

Save a file 

1. On the File menu or on the toolbar, click Save . 
The currently active worksheet is now saved. 

You may open the file using MC_Stimulus later on to continue your experiment. 

Save as 

Use this command to save your file under a new name, for example, if you like to use a file as a 
template for a new file. 

1. On the File menu, click Save As. 

2. Browse your folders and enter a file name. 

3. Click Save. 
The current worksheet is now saved under the new name. 

You may open the file using MC_Stimulus later on to continue your experiment. 

Import ASCII File 

Please see the chapter "Importing ASCII Files". 

Printing a channel 

1. On the File menu, click Print Setup to select a printer, paper format, and so on. 

2. Click Print Preview to preview the print output. 

3. Click Print   to print out the active channel of the active worksheet. 

9.6 Settings Menu 

Enable Compiler Warnings 

Cancel this option to disable the message boxes displaying compiler warnings during stimulus 
download. 

The two error messages that can be disabled are: "warning: signal length shorter than the 
maximum" and "warning: non zero last amplitude value". They may present a nuisance if you 
download multiple stimulus files in batch mode 

• On the Settings menu, select or deselect Enable Compiler Warnings. 
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10 Synchronizing Events 

10.1 Digital Output Signals (Sync Out) 

The output of the digital Sync Out output is a 5 V TTL signal. A logic state of 1 means 5 V, and a 
logic state of 0 means 0 V. Please note that the digital output is about 15 μs faster than the 
analog output. This small offset is generally sufficient to make sure that the Sync Out signal 
precedes the stimulation, which is important for synchronizing events. 

You can program the output signal of the Sync Out channel in the same way as the analog output 
signals, but due to the nature of a digital signal, only values of 0 and 1 are allowed. A Sync Out 
signal is generated each time when the STG is started. 

The output signal can be used for triggering external devices, for example, the data 
acquisition with the MC_Card of the ME System and the MEA System. Please note that if you 
use it for triggering the MC_Card, you should use output signals that have a duration of at least 
200 μs. Otherwise, it can happen that the MC_Card ignores trigger events. 

Note: No Sync Out signal is sent when the STG is stopped on a trigger event or by pressing the 
Start/Stop button, that is, if the trigger event occurs or the button is pressed when the STG has 
still been active. 

Timing of blanking signal 

If you have a MEA amplifier with blanking circuit in use, you can apply a blanking signal (TTL 
pulse) for transiently switching off the input stage of the amplifiers during the stimulus, thus 
avoiding the stimulus artifact. 

MCS recommends a minimum blanking pulse that starts with the stimulus and stops 100 μs after 
the stimulus. The fact that the digital output of the stimulus generator from MCS is about 15 μs 
faster than the analog output ensures that the blanking signal is delivered before the stimulus. It 
is very important that the blanking pulse is delivered shortly before the stimulus. 

The following example shows a blanking signal (programmed with MC_Stimulus) of 300 μs length 
for a biphasic pulse of 200 μs length. See also the MEA_Select Help or the MEA Amplifier with 
Blanking Circuit User Manual for more information. 

 

You can use the Auto Sync feature for autocreating the Sync Out pulses without entering values 
manually. Please see "Auto Sync for Autocreating Synchronous Sync Out Pulses". 
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10.2 Triggering Stimulation (Trigger In) 

The external trigger input has to be a TTL signal of at least 20 μs length. TTL pulses shorter than 
that may not be recognized by the stimulus generator. 

A TTL pulse is defined as a digital signal for communication between two devices. A voltage 
between 0 V and 0.8 V is considered as a logical state of 0 (LOW), and a voltage between 2 V and 
5 V means a 1 (HIGH). It is the same kind of signal as the output signal of the Sync Out output of 
the STG. 

The rising edge of the HIGH trigger input starts and stops the STG. The time lag between the 
rising edge of the TTL input and the stimulus output is 120 +/ 10 μs. The minimum distance 
between two trigger inputs is 20 ms, resulting in a maximum trigger frequency of 50 Hz. If a 
higher frequency is used, the stimulus generator is likely to miss trigger inputs. See the illustration 
below for more details on the timing. Please note that the digital Sync Out output is about 15 
μs faster than the analog outputs. See Digital Output Signal (Sync Out) for more information. 

Important: Please note that the timing and the amplitude of the analog output pulses may not 
be accurate for very small amplitudes (below 200 mV or below 100 μA) due to the intrinsic 
properties of the electronic parts of the stimulus generator. Please check the output signals with 
an oscilloscope if you use small amplitudes in your stimulus protocol. 

 

Custom switch for "remote-controlling" of the STG 

You can connect any device that produces TTL outputs to the Trigger In connector of the STG, for 
example a switch. For example, you can use a trigger for remote controlling the STG if it is not 
within reach during an experiment. It is also possible to set up advanced experiments where 
stimulation depends on preceding activities of the studied object. 

The following picture shows a suggested circuit diagram for a switch used for remote controlling. 
The resistor and capacitor work as a low-pass filter on the TTL signal and are necessary to reduce 
ringing of the signal. 
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10.3 Batch Mode 

You can download and run several stimulus files one after the other in the Batch mode. The first 
file in the list is downloaded and started directly after the download, or started manually with the 
software or hardware controls, or started on a trigger. After the first file has been run, the next 
file in the list is downloaded, and so on, until the last file in the batch list has been run. 

Triggering a sequence of stimulation protocols 

The Batch mode is useful if you want to start a sequence of different stimulation protocols one 
after the other on the same trigger. You set up the protocols and save them as separate stimulus 
files. Then, you set up a batch file with a list of the desired stimulus files. 

• The first trigger event starts the first file in the list. 

• When a file has been completed, the next file in the list is downloaded automatically. 

• When a trigger event occurs after the file has been run, the next file is started, and so on. 

• When a trigger event occurs during the run of a file, the run is stopped, and the next file in the 
list is downloaded. The next trigger event starts the next file. 

• Deselect the option Start STG after Batch Download on the Settings menu if you want to start 
the protocols on a trigger or manually with the software or hardware controls. If the option 
Start STG after Batch Download on the Settings menu is selected, the STG starts each file 
directly after the download without waiting for a trigger event. 

Splitting up stimulation protocols to circumvent the memory limitation 

If the option Start STG after Batch Download on the Settings menu is selected, the STG starts 
each file directly after the download, which is only useful if you need to circumvent the memory 
limitation of the STG. Split up your pulse protocol into several stimulus files and run them in 
Batch mode. 

Setting up a batch file 

You have to set up a batch file (.stb) first, which lists the full path of all files that you like to 
download as a batch. The batch file has to be exactly in the following format. This example is a 
batch list with three different pulse protocols. Replace the file paths with the correct path of the 
files of your choice. 
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Multi Channel Systems MCS MC_Stimulus 
Batch Control File 
Version 1.00 
c:\Program Files\Multi Channel Systems\MC_Stimulus\BatchExample\Baseline.stm 
c:\Program Files\Multi Channel Systems\MC_Stimulus\BatchExample\Tetanus.stm 
c:\Program Files\Multi Channel 
Systems\MC_Stimulus\BatchExample\TestResponse.stm 

Operating the STG in Batch mode 

Important: You can operate the STG in Batch mode only with a valid computer connection. A 
file in the batch list is only downloaded after the preceding file has been run. 

1. On the Batch menu, click Open to open a batch file. 
The Open dialog box appears. 

2. Browse your folders and select a valid batch file, for example the sample file TetanusBatch.stb in 
the MC_Stimulus program folder. 
 

 

3. The Batch Status Display opens. It lists all stimulus files in the batch and the duration of 
stimulation. 
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4. On the Batch menu, click Start to start the download of the first file in the batch list (and the STG 
if the option Start STG after Batch Download on the Settings menu is selected). 
The progress of the pulse protocol is displayed in the Status column of the Batch Status 
Display. 

5. Click Stop on the Batch menu to stop the batch if necessary. 

6. Close the Batch Status Display with the Close command. 

 

Warning: The STG starts immediately after the download if the option Start STG after Batch 
Download on the Settings menu has been selected. Make sure to deselect this option if you do 
not want to start the stimulation right away. 
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11 Analog Output Signals 

11.1 Output Modes 

The stimulus generator operates in voltage and current mode and has separate voltage and 
current outputs for each channel. Regardless of the operation mode selected in MC_Stimulus, 
both current and voltage outputs are active. Please make sure that you use the appropriate 
output for your experiment. The main difference between the current outputs and the voltage 
outputs is described in the following. 

In voltage mode, the voltage level is held constant and the current output depends on the 
electrode resistance (the higher the electrode resistance, the lower is the output current). 

In current mode, the stimulus generator guarantees a stable current output independent of the 
electrode resistance, where the voltage is defined by Ohm's law. The higher the electrode 
resistance, the higher is the output voltage. Therefore, the kinetic properties of the stimulus 
output is affected by the load resistance, that is usually the electrode resistance. If the 
resistance is too high, the output current is limited by the compliance voltage, that is, too high 
resistances will result in a clipping of the output signal. 

 

Warning: Do not connect any device between a voltage (U) and a current output (I). This could 
damage the stimulus generator. 

Please regard the time and voltage/current resolution of the stimulus generator. The minimum 
pulse has an amplitude of 2 mV in voltage mode or 1 μA in current mode (supported by 
MC_Stimulus II; the firmware/DLL supports a 13 bit resolution, which means 200 nA for an output 
current range of 0.8 mA), and a time length of 20 μs. Please note that if you work near these 
limits, that is, if you use very small amplitudes or very short pulses, the output waveform may not 
match the programmed waveform. 

 

Ground 

All up to 8 STG channels are optically isolated from each other. Each channel has an independent 
ground output (GND), which is usually connected to the ground of the experimental setup, for 
example the amplifier, so that all devices refer to the same ground. Please make sure that you 
always use the appropriate ground for the channel in use. 

11.2 Voltage Mode 

• If you operate the STG in voltage mode, you will usually use the +U and GND outputs. The output 
signal is identical with the programmed signal in the normal ranges of the electronics' accuracy. 
See illustration "Voltage mode: Standard Setup". 

• It is strongly recommended to short-circuit the +I and I outputs with the provided cables for 
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saving power and suppressing noise. Otherwise, the stimulus generator tries to hold a stable 
current against the indefinite resistance of the open current output. 

• The output signals are inverted (multiplied by 1) if you use the U outputs.  

• If you use the voltage between +U and U, the output signal amplitude is doubled. U represents 
the ground (replaces GND) in this case. See illustration "Voltage mode: Doubled output signal 
amplitude". 

• A bipolar stimulation is recommended for extracellular recordings from microelectrode arrays 
(MEAs) if a very high output signal density in a defined area between two neighboring 
stimulating electrodes is needed. The current that is delivered by the first electrode flows directly 
back to the second electrode so that the surrounding tissue is not affected. See illustration 
"Voltage mode: Bipolar stimulation". 

• In the following example, you see a signal in the MC_Stimulus display and the resulting output 
signals for the different connection options (viewed in an MC_Rack Data Display). 

Programmed stimulus protocol viewed in MC_Stimulus: 

 

STG output signals: 
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• For amplitudes greater than 200 mV, The time lag between the Sync Out output and the 
voltage outputs is approximately 12 μs (+/ 2 μs). For more information on the kinetics of smaller 
amplitudes, please see "Amplitude-Dependant Time Lag". 
 



Stimulus Generator 1000 Series User Manual 

52 

 

Fig. 2 Voltage output 1 V and Sync Out. 

Screen shot from a standard oscilloscope triggered on the Sync Out pulse (see "Measuring output 
signals with an oscilloscope"). Cyan trace = voltage output (+U), yellow trace = inverted voltage 
output (U), green trace = TTL output from the Sync Out. 

Setup suggestions for voltage mode 

The following illustrations show circuit diagrams of suggested setups. Please note that you can use 
unshielded twisted pair cables (wires twisted round each other) instead of a shielding to 
prevent the amplifier from picking up noise. The experimental ground can be, for example, the 
amplifier's ground or a Faraday cage. 

If you use the stimulus generator together with a standard MEA amplifier, you can also use the 
provided 3-polar cable for directly connecting the stimulus generator to the electrode inputs of 
the MEA amplifier. Please note that a shielded cable is generally not necessary if you use a 
MEA1060 amplifier with blanking circuit. For more details on the recommended setup for this 
amplifier type, please refer to the MEA1060 Amplifier with Blanking Circuit User Manual. 
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11.3 Current Mode 

• If you use current for stimulation, you will usually use the +I and GND outputs. See illustration 
"Standard setup". 

• The output signals are inverted (multiplied by 1) if you use the I outputs. 

• If the load resistance, that is, the electrode impedance is very high, the output voltage can 
get very high, too. The stimulus generator limits the output voltage to 75 V between +I or I and 
GND. The guaranteed compliance voltage is 60 V. 

• The current output of the STG is limited by the compliance voltage and the electrode 
impedance. If the maximum load resistance for a given current output is exceeded, the 
compliance voltage (60 V between +I and GND) of the STG will not be sufficient for delivering 
enough current, and the output will be clipped. You can calculate the maximum load resistance 
by Ohm's law. For example, if you want to program a 100 μA pulse, the maximum load resistance 
will be 600 kilohms. According to Ohm's law: R = U / I = 60 V / 100 μA = 600 kΩ, that is, 60 V are 
sufficient for delivering a current of 100  μA at a load resistance of 600 kΩ. Therefore, if you use 
current driven stimulation, you should always take the impedance of the stimulating electrodes 
into account when planning your stimulus protocol. You should also keep in mind that most 
electrodes or amplifiers support only limited voltages. 

• You can increase the compliance voltage to 120 V by using the +I and –I outputs. The output 
current even at the maximum output voltage of 150 V should not be dangerous to human health 
because the maximum output current in current mode is only +/ 0.8 mA. See illustration 
"Doubled maximal output voltage". 

• A bipolar stimulation is recommended for extracellular recordings from microelectrode arrays 
(MEAs) if a very high output signal density in a defined area between two stimulating electrodes 
is needed. The current that is delivered by the first electrode flows directly back to the second 
electrode so that the surrounding tissue is not affected. See illustration "Dipolar stimulation". 

• For amplitudes greater than 100 μA, the time lag between the Sync Out output and the current 
outputs is approximately 15 μs (+/ 2 μs). For more information on the kinetics of smaller 
amplitudes, please see "Amplitude-Dependant Time Lag". 
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Fig. 3 Current output 100 μA and Sync Out. 

Screen shot from a standard oscilloscope triggered on the Sync Out pulse (see "Measuring output 
signals with an oscilloscope"). Cyan trace = current output (+I), yellow trace = inverted current 
output (I), green trace = TTL output from the Sync Out. 

Setup suggestions for current mode 

The following illustrations show circuit diagrams of suggested setups. Please note that for current 
stimulation, you should use shielded cables to protect your setup against electromagnetic 
interference. The experimental ground can be, for example, the amplifier's ground or a Faraday 
cage. 
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11.4 Measuring Output Signals with an Oscilloscope 

For test purposes, you can measure the output signals with an oscilloscope.  

Most standard oscilloscopes have a probe with a ground cable. This probe is usually connected to 
the oscilloscope via a BNC socket. What you do for measuring the voltage output is the 
following: You plug in the standard STG cables into the +U output and the corresponding GND 
output. You then touch the open end of the cable from the +U output with the probe from the 
oscilloscope, and the open end of the cable from the GND output with the ground cable from the 
probe. This means you measure the potential difference between the +U output and ground. 

Please note that you need a resistor in parallel to measure the current output properly because 
oscilloscopes measure voltages. If the input resistance of the oscilloscope is too low, the voltage 
output of the STG will be small as well, and you will not see any signals on the oscilloscope. MCS 
recommends a resistor of 10 kΩ because the output signal of the current output should then be 
identical to the output signal of the voltage output. You can use the same test protocol 
(regardless of the output mode) for the current and voltage outputs, and compare the signals. As 
an alternative, you can also use a resistor that mimics the electrode resistance for testing your 
experiments. 

What you do is, you plug in cables into the +I output and into the GND output of the STG. You 
then use alligator crimps for connecting a 10 kiloohms resistor between the two open ends of 
the cables. You then touch the cable on one side of the resistor with the probe and on the other 
side with the ground of the probe. That is, you measure the potential difference over the 
resistor. You can then calculate the current output according to Ohm's law (U = R * I). For 
example, if you stimulate with 100 μA, the voltage over the 10 kiloohms resistor has to be U = 
10000 Ω * 0.1 mA = 1000 mV = 1 V. 

The following illustration shows four possible combinations of connecting the current outputs on 
the front panel of the stimulus generator to the oscilloscope. Again, it is important that unused 
current outputs are connected to ground. 
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11.5 Rise Time 

The rise time of the voltage output is constant and independant from the stimulus protocol. 
The rise time of the current output is no fixed hardware property.The kinetics depend on the 
amplitude of the current pulse and the load resistance, that is, generally the electrode 
impedance. The resistance affects the kinetics much stronger than the amplitude. 

Generally, this does not make much difference for biological applications. If you have very time-
critical applications, or if you use very short pulses, you should check the output of the STG 
with an oscilloscope before starting the experiment. 

Amplitude dependency of rise time 

The higher the current amplitude, the higher the rise time. The rise time (1090%) was 
measured with increasing current amplitudes and a constant load resistance of 10 kilohms. The 
output current slope can be estimated at 100 μA/μs, but the relationship is not linear as shown 
by the following (Boltzmann fitted) curve. 
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Resistance dependency oft rise time 

The higher the load resistance, the higher the rise time. The rise time (1090%) was measured 
with increasing load resistances and a constant current amplitude of 100 μA. For 100 μA pulses, 
the relationship is linear up to the maximum load resistance (please see "Current Mode") as 
shown by the following (Boltzmann fitted) curve. 

 

Stimulus output comparison 

The following figures are examples for demonstrating how the amplitude and resistance will 
affect the kinetics of a current pulse. These images document also that in contrast to the 
current mode, in voltage mode, the rise time is constant and not dependant on the amplitude 
or load resistance. 

The graphs were generated by a standard oscilloscope. The devices were set up according to the 
recommendations under "Voltage Mode" and "Current Mode". The same pulse protocol and the 
same channel number of the STG outputs was used for measuring the voltage and the current 
output. The yellow traces show the voltage (U) output; cyan traces are from the current output 
(+I) with a load resistance of 10 kΩ, and green traces show the TTL output from the Sync Out 
that was used for triggering the oscilloscope. 
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Fig. 4 Rise time with programmed 500 mV and 50 μA pulses, 10 kΩ load resistance. 

The rise time is about 4 μs for the 500 mV voltage pulse (yellow), and < 1 μs for the 50 μA current 
pulse (cyan). 

 

Fig. 5 Rise time with programmed 5 V and 500 μA pulses, 10 kΩ load resistance. 

The kinetics and the rise time of the 5 V voltage pulse (yellow) are comparable to the 500 mV 
pulse. The approx. 4 μs rise time of the 500 μA current pulse (cyan) is significantly higher than the 
rise time of the 50 μA pulse.  
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Fig. 6 Rise time with programmed 5 V and 500 μA pulses, 100 kΩ load resistance. 

With a higher load resistance, the current pulse (cyan) shows  a different kinetic behavior: There is 
no overshoot, and the rise time increases significantly (about 20 μs). 

11.6 Amplitude-Dependant Time Lag 

For most standard applications, you can assume that the STG output is identical (in normal 
tolerances of electronic components) to the stimulus protocol in the WYSIWYG editor of the 
MC_Stimulus program. However, there are some special situations where you should confirm the 
output with an oscilloscope. The deviation from the programmed pulse protocol is due to the 
intrinsic properties of the electronic components and may vary slightly between different STG 
units. As there is no true linear relationship between, for example, the amplitude dependant time 
lag and the amplitude size, the STG's behavior cannot be precisely predicted, and therefore it is 
not possible to show a corrected output in the MC_Stimulus display. The only possibility is to 
measure the output with an oscilloscope before starting the experiment. 

In the following, you will find some general rules that might help you to decide whether your 
planned pulse protocol is subject to these limitations. It might be necessary to check and adapt 
your pulse protocol according to these findings. 

The actual output as shown in the figures below was documented by a standard oscilloscope. The 
same pulse protocol and the same channel number of the STG outputs were used for measuring 
the voltage and the current output. The devices were set up according to the recommendations 
under "Voltage Mode" and "Current Mode". 

For very small pulse amplitudes (< 200 mV or < 100 μA), which are generally not used in 
biological applications, the time lag between the digital Sync Out output (as a reference point) 
and the analog output signals increases with a decreasing amplitude, that is, the lower the 
amplitude, the higher the time lag. You should check the actual pulse amplitude and 
duration if you need short pulses with a high accuracy. It might be necessary to program longer 
pulses to make sure that (a) the output amplitude matches the setpoint voltage and (b) the 
duration is long enough for your application. This might be especially important if you apply 
biphasic current pulses to discharge the electrode with the inverted phase. In the following, a few 
general examples and recommendations are described. 

Time lag of positive phase 



Stimulus Generator 1000 Series User Manual 

62 

The time lag of the positive phase (for the +U and +I outputs, negative phase for U and I) is 
higher than that of the negative phase. If the polarity switches directly from negative to 
positive, you will observe a time lag of a few microseconds at 0 V in-between the phases. 

For pulses with positive phase (for the +U and +I outputs, negative phase for U and I), the time 
lag of the falling edge is negligible in contrast to the time lag of the rising edge. This means, 
the increased time lag directly affects the duration of the pulse, that is, positive pulses with low 
amplitudes are shortened. 

 

Fig. 7 STG output with programmed biphasic 50 mV pulses, positive phase first, duration 100 
μs for each phase. 

The positive phase of the +U output (cyan trace) and the negative phase of the U output (yellow 
trace) are shortened. The time lag of the positive phase with the rising edge of the Sync Out 
output (green trace) as a reference point is 54 μs in this example. 
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Fig. 8 STG output with programmed biphasic 50 mV pulses, negative phase first, duration 100 
μs for each phase. 

This figure shows the output of the same programmed pulse, but with inverted polarities. 
Regardless whether the positive or the negative phase comes first, always the positive phase of 
the +U output shows a higher time lag and is shorter than the negative phase. If the polarities are 
switched directly from negative to positive, there is a time lag at 0 mV between the phases. 

Deviation of the amplitude 

If the resulting pulse is much too short, the electronics might also not be able to reach the 
setpoint voltage or current in the short time, resulting in a deviation of the amplitude, too. 
Pulse protocols that are programmed near the resolution limit of the STG, that is, with very small 
amplitudes and short pulses (for example, 50 mV and 20 μs) may not generate any output at all. 

If you have a pulse train with very short pulses near the resolution limit of the STG, the 
amplitude of the first pulse in the train might be lower than the following pulses. 
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Fig. 9 STG output with programmed biphasic 50 mV and 5 μA pulses, duration 100 μs for each 
phase. 

The negative phase of the inverted voltage output (U, yellow) and the positive phase of the 
current output (+I, cyan) are more delayed and significantly shorter than the other phases. The 
delay of the current output of the 5 μA positive phase is so high that the electronics are not able 
to generate any current output in the short duration of the pulse at all, that is, the actual current 
output is zero. 

Decreasing time lag with increasing pulse amplitude 

The following figures illustrate that the behavior of the STG's electronics improves with increasing 
amplitude. With amplitudes greater than 200 mV or 100 μA, the time lag between the Sync 
Out as a reference point and the voltage/current outputs is short and stable (see data sheet). 

The yellow traces show the inverted voltage (U) ouput; cyan traces are from the current output 
(+I) with a load resistance of 10 kΩ, and green traces show the TTL output from the Sync Out 
that was used for triggering the oscilloscope. 



Analog Output Signals 

65 

 

Fig. 10 STG output with programmed biphasic 100 mV and 10 μA pulses, duration 100 μs for 
each phase. 

In comparison to the 50 mV pulses, the time lag of the negative phase of the U output (yellow) is 
much smaller (less than 10 μs), and the actual current output amplitudes (cyan) match the setpoint 
current. 
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Fig. 11 STG output with programmed biphasic 200 mV and 20 μA pulses, duration 100 μs for 
each phase. 

With a voltage amplitude of 200 mV (U, yellow), there is almost no delay between the positive 
and negative phase. The top part of the figure shows all three voltage steps (50 mV, 100 mV, and 
200 mV). You can clearly see that the delay between the phases decreases significantly with 
increasing pulse amplitude. 
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Fig. 12 STG output with programmed 200 mV and 20 μA pulses, duration 100 μs for each phase. 

About 10 μs is the standard delay of the voltage output at 200 mV (U, yellow). The delay of the 
current output at 20 μA (cyan) is increased due to the small current amplitude. At 100 μA or 
higher, the time lag of the current output would be comparable to the standard delay of the 
voltage output. 

11.7 Capacitive Behavior of Stimulating Electrodes 

Regarding the generally used stimulus pulses, stimulating electrodes behave as plate capacitors. 
They need some time to discharge themselves after stimulation. As a result, artifacts interfere with 
the recording, and electrodes deteriorate over time due to electrolysis. This effect takes place 
especially in current mode because the current cannot flow back to the stimulus generator due to 
the high output resistance in current mode and thus is kept in the electrode. 

To reduce the effect described abovew in current mode, you should use biphasic pulses for 
stimulation. The stimulus signal should be immediately followed by an inverse signal of the same 
area (product of current and time), which helps to discharge the electrode. The easiest way is to 
use the same signal amplitude with an opposite polarity. 

Multi Channel Systems recommends to use voltage driven stimulation. In voltage mode, it is not 
necessary to use a biphasic stimulation for discharging the electrodes, because the electrode 
should be discharged at a voltage of 0, that is, it would be sufficient to apply the negative phase 
only. 

 

Warning: When using MEA electrodes of TiN material, stimulation with a higher amplitude is 
possible if you apply the negative pulse first.   Also, regard the safe charge-injection limit 
as described in the MEA User Manual. Otherwise, electrodes can be damaged during stimulation. 
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The following illustration shows the effect of a biphasic current pulse on the discharge of the 
stimulating electrode. As you can see, the first monophasic pulse is followed immediately by a 
pulse of the opposite polarity and the same product of current and time. 
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12 Troubleshooting 

12.1 About Troubleshooting 

Most problems occur seldom and only under specific circumstances. In most cases, it is only a minor 
problem that can be easily avoided or solved. 

If the problem persists, please contact your local retailer. The highly qualified staff will be glad to 
help you. Please inform your local retailer as well, if other problems that are not mentioned in this 
documentation occur, even if you have solved the problem on your own. This helps other users, 
and it helps MCS to optimize the instrument and the documentation. 

Please pay attention to the safety and service information (chapter "Important Safety advice" in 
the User Manual / Help). Multi Channel Systems has put all effort into making the product fully 
stable and reliable, but like all high-performance products, it has to be handled with care. 

12.2 Technical Support 

Contact your local retailer immediately if the cause of trouble remains unclear. Please understand 
that information on your hardware and software configuration is necessary to analyze and finally 
solve the problem you encounter. 

If you have any questions or if any problem occurs that is not mentioned in this document, please 
contact your local retailer. The highly qualified staff will be glad to help you. 

Please keep information on the following at hand 

• Description of the error (the error message text or any other useful information) and of the 
context in which the error occurred. Try to remember all steps you had performed immediately 
before the error occurred. The more information on the actual situation you can provide, the 
easier it is to track the problem. 

• The serial number of the device. You will find it on the device. 

• The software (SW) and hardware (HW) version you are currently using. On the Help menu, 
click About. The displayed dialog box shows the version numbers. 

• The operating system and service pack number on the connected computer. 

• The hardware configuration (microprocessor, frequency, main memory, hard disk) of the 
connected computer. This information is especially important if you have modified the computer 
or installed new hard- or software recently. 

12.3 Error Messages 

This chapter explains error messages to you that may occur during normal operation. They do not 
present a reason to worry and can be easily avoided. 

Download 

These error messages may occur during download on the STG. Please note that you can switch off 
some of these messages if they disturb your experiment. See chapter "Downloading Stimuli" for 
more details on downloading. 
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The worksheet is empty. No data is present that 
can be downloaded. Please create a stimulus or 
open a stimulus file before downloading.  

 

There is no stimulus generator connected to the 
computer or the STG may be switched off. Please 
check the computer connection and the status 
lamp of the STG. 

 

There is no valid connection to an STG. 
Download of data is not possible. Please check 
the computer connection and the status lamp of 
the STG. 

 

The last voltage/current values of the named 
channels are not zero. The last used values of 
these channels are kept until the STG is stopped. 

 

ASCII Import 

These error messages relate to a wrong file format. Please see chapter "Supported File Format" 
for more information. 

 

The named line contains an 
unexpected character. 

 
 

The channel number 
specification has to precede 
the data. The channel 
number either lacks or the 
specified number does not 
exist (for example, number 
13). 
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Each data column must have 
a header (value, time, or 
repeat). 

 
 

The number of data columns 
has to be consistent for all 
lines in a given ASCII file (for 
example, value, time, value, 
time). This error message 
indicates that there is a 
current/voltage value or a 
time point missing in line 12. 

 

The ASCII file contains 
current/voltage values 
outside the STG's range. For 
example, if the STG's output 
range is +8000 mV, all values 
above +8000 mV are set to 
+8000 mV. 

12.4 Strong Peak Artifacts 

Strong discharges or other artifacts of the output voltage or current. 

Possible causes: 

One or both current outputs are open, that is, nothing is connected to them. The stimulus 
generator tries to hold a stable current against the indefinite resistance of the open current 
output. Therefore, the stimulus generator will increase the output voltage on the open current 
outputs to its maximum, which will result in a heavy load on the power supply. This situation may 
cause the power supply to become unstable, which may lead to artifacts on all channels. 

• In voltage mode: Short-circuit the +I and I outputs with the provided cables for saving power 
and suppressing noise. Please see also the recommended setups in the chapter Voltage Mode. 

• In current mode: Connect the unused current output to ground (GND). Please see also the 
recommended setups in the chapter Current Mode. 

12.5 Output Signal Does not Match Programmed Signal 

The amplitude or the duration of the output pulses differs from the programmed signal. 

Possible causes: 

The stimulus protocol works near the resolution limits of the STG, that is, the pulses are very short 
or the amplitudes very low (smaller than 200 mV or 100 μA). Due to the intrinsic properties of 
the electronics, the timing and the amplitude of short or small pulses are limited. Please see also 
the chapters "Rise Time" and "Amplitude-Dependant Time Lag". 

• Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude 
and timing of the pulses will match your requirements. 
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You operate the STG in current mode, and the electrode resistance of the stimulating 
electrodes is too high. According to Ohm's law, the electrode resistance directly affects the 
kinetics of the current output. The rise time increases with an increasing electrode resistance. If 
the electrode resistance is too high for the compliance voltage, the output signal will be clipped. 

• Try to stimulate in voltage mode. 

• Try to use stimulating electrodes with a lower impedance. 

• Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude 
and timing of the pulses will match your requirements. 
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13 Appendix 

13.1 Technical Specifications STG1001/2 

Operating temperature 10 °C to 35 °C 

Storage temperature    0 °C to 50 °C 

Dimensions (W x D x H) 170 mm x 240 mm x 60 mm 

Weight 1.2 kg 

Fuse  1 A @ 100 to 230 V, slow blow 

Supply voltage (external 
power supply) 

100240 VAC @ 47 to 63 Hz 

Number of analog output 
channels 

1 (STG1001) or 2 (STG1002) 

Output voltage 8 V to + 8V @ max. +/20 mA 

Output voltage resolution 2 mV 

Ouput voltage slope 4 V/μs 

Rise time (1090%) 3 to 5 μs @ delta U = 1 V or @ delta I = 0.4 mA & RL = 10 kilohms 

Output current 0.8 mA to +0.8 mA @ max. 100 V compliance voltage (between 
+I and I) 

Output current resolution 200 nA 

Output current slope  100 μA/μs @ RL =  10 kilohms 

Time lag between Sync Out 
and voltage output 

12 μs +/-2 (@ amplitude > 200 mV) 

Time lag between Sync Out 
and current output 

15 μs +/-2 (@ amplitude > 100 μA & RL =  10 kilohms) 

Resolution  13 bit 

Time resolution 20 μs 

Output signals Freely programmable (rectangular, ramp, sinusoidal) 

Maximum frequency 
(rectangular waveform) 

25 kHz 

Timing on external trigger 

Minimum time length of 
trigger input (TTL) 

20 μs 

Time lag between trigger 
input and stimulus output 

120 +/ 10 μs 

Time lag between trigger 
input and Sync Out 

110 +/ 10 μs 

Maximum trigger input 
frequency 

50 Hz 

Interface and connectors 

Sync Out for synchronization 
with following devices 

Digital channel via coax cable 

Trigger In for synchronization 
with preceding devices 

Digital channel via coax cable 

Interface (connection to 
computer)  

RS232 serial port  

Download rate 56 Kbps 

MC_Stimulus program  
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Operating system Windows© 98, ME, NT, 2000, or XP; English and German versions 
supported 

Data import ASCII file format 

13.2 Technical Specifications STG1004/8 

Operating temperature 10 °C to 35 °C 

Storage temperature    0 °C to 50 °C 

Dimensions (W x D x H) 275 mm x 330 mm x 115 mm 

Weight 4.8 kg 

Fuse  0.2 A @ 230 V, slow blow; 0.4 A @ 115 V, slow blow 

Supply voltage Available types: 100 VAC, 115 VAC, or 230 VAC @ 50 to 60 Hz 

Number of analog output 
channels 

4 (STG1004) or 8 (STG1008) 

Output voltage 8 V to + 8V @ max. +/-20 mA 

Output voltage resolution 2 mV 

Ouput voltage slope > 4 V/μs 

Rise time (10-90 %) 3 to 5 μs  @ delta U = 1 V or @ amplitude > 100 μA & RL =  10 
kilohms 

Output current 0.8 mA to +0.8 mA @ max. 100 V compliance voltage (between 
+I and I) 

Output current resolution 200 nA 

Output current slope  100 μA/μs @ RL =  10 kilohms 

Time lag between Sync Out 
and voltage output 

12 μs +/-2 @ amplitude > 200 mV 

Time lag between Sync Out 
and current output 

15 μs +/-2 @ amplitude > 100 μA & RL =  10 kilohms) 

Resolution  13 bit 

Time resolution 20 μs 

Output signals Freely programmable (rectangular, ramp, sinusoidal) 

Maximum frequency 
(rectangular waveform) 

25 kHz 

Timing on external trigger 

Minimum time length of 
trigger input (TTL) 

20 μs 

Time lag between trigger 
input and stimulus output 

120 +/ 10 μs 

Time lag between trigger 
input and Sync Out 

110 +/ 10 μs 

Maximum trigger input 
frequency 

50 Hz 

Interface and connectors 

Sync Out for synchronization 
with following devices 

Digital channel via coax cable 

Trigger In for synchronization 
with preceding devices 

Digital channel via coax cable 

Interface (connection to 
computer)  

RS232 serial port  

Download rate 56 Kbps 
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MC_Stimulus program 

Operating system Windows© 98, ME, NT, 2000, or XP; English and German versions 
supported 

Data import ASCII file format 

13.3 Contact Information 

Local retailer 

Please see the list of official MCS distributors on the MCS web site. 

User forum 

The Multi Channel Systems User Forum provides the opportunity for you to exchange your 
experience or thoughts with other users worldwide. 

Mailing list 

If you have subscribed to the General Electrophysiology Mailing List, you will be automatically 
informed about new software releases, upcoming events, and other news on the product line. 
You can subscribe to the list on the MCS web site. 

 

www.multichannelsystems.com 

13.4 Ordering Information 

Product information is subject to change without notice. Please contact your local retailer for 
pricing and ordering information. 

Stimulus/pulse generators 

Product Product 
Number 

Description 

1-Channel stimulus 
generator 

STG1001 

2-Channel stimulus 
generator 

STG1002 

4-Channel stimulus 
generator 

STG1004 

8-Channel stimulus 
generator 

STG1008 

General purpose stimulators for a very wide variety of 
applications. Flexible and easy-to-use MC_Stimulus 
software enables complex stimulus waveforms (both 
current and voltage). Stimulus isolation units are 
integrated in the STG for each channel. With additional 
digital trigger in- and output. 

4-Channel stimulus 
generator 

STG2004 

8-Channel stimulus 
generator 

STG2008 

Advanced version with 4 additional digital trigger in- 
and outputs. About 100 x faster download via USB. 16 
times more memory for long-time stimulation. 

Spare parts 

Product Product 
Number 

Description 

Shielded 3-pole 
cable 

C3P For connecting the STG to MEA1060 amplifier, with 
ground 
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Red single pole 
cable 

CR-BC 

Black single pole 
cable 

CB-BC 

Blue single pole 
cable 

CBL-BC 

For connecting the STG to the MEA1060-Inv/Up-BC 
amplifier with blanking circuit 

Red single pole 
cable 

CR 

Black single pole 
cable 

CB 

For connecting the STG to the standard MEA1060-Inv/Up 
amplifier 

MEA amplifiers 

Product Product 
Number 

Description 

MEA amplifier for 
inverted microscopes 

MEA1060-Inv 

MEA amplifier for 
upright microscopes 

MEA1060-Up 

Probe interface and 60 channel pre- and filter 
amplifier with custom gain and bandwidth 

MEA amplifier with 
blanking circuit for 
inverted microscopes 

MEA1060-Inv-BC 

MEA amplifier with 
blanking circuit for 
upright microscopes 

MEA1060-Up-BC 

Probe interface and 60 channel pre- and filter 
amplifier with custom gain and bandwidth. The 
blanking circuit prevents the amplifier from getting 
saturated and thus prevents stimulus artifacts. 
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B 
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Batch 
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Bipolar stimulation 53, 57 
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C 
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behavior of electrodes......................68 

Cascade 39 

Change Time Unit 15 
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Compiler warnings 41 

Connecting 
the STG to an amplifier...................... 6 
the STG to an oscilloscope ............... 57 

Contact 
information....................................... 77 

Continuous 
stimulation ........................................ 14 

Copy 
row..................................................... 39 
shortcut key ...................................... 40 

Count 15 

Creating 
Autosync pulses ................................ 23 
Stimuli ............................................... 11 

Current 
capacitive behavior of electrodes.... 68 
electrode impedance........................ 58 
maximum output current ....54, 75, 76 
measuring output with an oscilloscope
........................................................... 57 
oscilloscope ....................................... 54 
output mode.........................11, 49, 54 
resolution .......................................... 11 
time lag ............................................. 61 

Cursor 33 

Cut 
rows ................................................... 39 
shortcut key ...................................... 40 

D 
Data 

ASCII file format ............................... 26 
download .......................................... 37 
save.................................................... 40 

Digital 
blanking signal ................................. 43 
input ..............................................6, 44 
output ...........................................6, 43 
port...................................................... 6 

Dipolar 
stimulation ..................................53, 57 

Display 
Auto Sync output.............................. 23 
scrolling ............................................. 33 
selecting channels............................. 33 
zooming ............................................ 33 

Downloading 
batch mode ....................................... 45 
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